
Instalación en Ubuntu
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Introdución

Como xa se dixo, a versión de Ubuntu na que se elaborou o curso é a Ubuntu Desktop 13.10 de 64 bits. Tamén se probou na versión
Ubuntu Desktop 14.04 de 64 bits

• 

A razón de instalar cada compoñente por separado é que nos vai permitir ter un maior control de todo canto se precisa e ademais vai poder
permitir que cada lector instale os compoñentes que precise en función dos que xa ten instalados.

• 

Compoñentes:• 

O OpenJDK (Java Development Kit), versión libre do JDK liderada por Oracle.
Como xa se indicou vaise instalar o JDK no canto do JRE (MV de Java), por se alguén desexa programar a maiores en Java en
consola ou con outros IDEs.
Nesta ocasión vaise facer uso de OpenJDK e non do JDK de Oracle, porque xa vén nos repositorios de Ubuntu.
Quen o desexe pode descargar o JDK orixinal de Oracle e instalalo seguindo os pasos:
http://www.oracle.com/technetwork/java/javase/downloads/index.html.

O IDE (Integrated Development Enviroment) de Eclipse.

O SDK (Software Development Kit) de Android

O ADT Plugin (Android Development Tools) para Eclipse. Permitirá facer uso dende o IDE do SDK de Android.

Quen desexe instalar todo isto en Ubuntu con entorno Unity e non se sinta con soltura no seu manexo, na parte III do seguinte curso pode
observar como interactuar con Unity: Curso Platega: Ubuntu Desktop. Un sistema dual (MS Windows / GNU/Linux)

• 

Instalación OpenJDK

Vaise instalar a versión 7.• 
En http://openjdk.java.net pódese obter máis información sobre esta plataforma.• 

Instalación OpenJDK• 
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Unha posibilidade pode ser dende o Centro de Software.

• 

Procurar OpenJDK.

• 

Pódese marcar que se instale o paquete icedtea-X-plugin que é o plugin para os navegadores Web. Pero ...

• 

... vaise instalar dende o Terminal. Premer no botón de Inicio, procurar Terminal e lanzalo.

• 
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Con apt-cache search openjdk vense os paquetes dispoñibles. Entre eles, o mendionado icedtea-X-plugin e o metapaquete default-jdk,
que sempre vai instalar a versión máis recente do JDK de OpenJDK.

• 

Executar sudo apt-get install default-jdk icedtea-7-plugin para instalar os dous paquetes.

• 

Información sobre o que se vai instalar. Indicar que Si se desexa continuar.

• 

Comprobación das versións do compilador de Java (javac -version) e da MV de Java (JRE) (java -version).

• 

Instalación do IDE Eclipse

A continuación instalarase o IDE de Eclipse, cuxo proceso de instalación é simplemente descargar e descomprimir un paquete, sen máis.• 
En http://eclipse.org/ está o sitio do IDE.• 

Instalación IDE Eclipse• 
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Unha posibilidade sería instalar Eclipse dende o Centro de Software.

• 

Pero a versión do repositorio é a 3.8.1 e ...

• 

• 
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En http://www.eclipse.org/downloads/ podemos atopar a última versión. A imaxe amosa a versión 4.3.1. Na actualiadade é a 4.4.1. Neste
caso descárgase a versión de 64 bits do IDE de Java EE (Enterprise Edition) por ser máis completa cá do IDE de Java, pero con esta última
tamén sería suficiente. Cada quen que baixe a versión de 64 ou 32 bits en función do seu S.O.

Descomprimir o ficheiro. Nota: na versión 13.10 de Ubuntu dá un erro ao descomprimir este paquete dende o entorno gráfico.

• 

Nese caso descomprimir con tar xf eclipse-jee......

• 

Carpeta Eclipse que xa contén o IDE, listo ...

• 

• 
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... para traballar. Facer dobre click sobre o executable (asegurarse que teña permisos de execución).

Abríndose o IDE. Versión da imaxe: 4.3.1 (Kepler). Imaxe actual 4.4.1 (Luna)

• 

Pregunta onde se desexan gardar os proxectos.

• 

O IDE funcionando. Pero, pero !!!!! Só está dispoñible para o usuario que o baixou e non para os demais do sistema. Isto non é desexable
nunha aula.

• 

IDE Eclipse para tódolos usuarios

Para que o IDE Eclipse estea dispoñible para tódolos usuarios do sistema, só é preciso poñer o cartafol Eclipse nunha ruta accesible por
todo usuario. Neste caso vaise facer uso da máis recomendada /opt/eclipse.

• 

Logo só resta axustar o propietario e os permisos do cartafol.• 
Pódese facer todo isto dende o contorno gráfico pero vaise realizar dende a consola con sudo.• 
Finalmente crearase un menú para que calquera usuario poida lanzar o IDE dende o Botón de Inicio do Lanzador.• 

Instalación IDE Eclipse para tódolos usuarios• 

https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_15.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_16.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_17.jpg


Mover o cartafol eclipse: sudo mv Descargas/eclipse /opt/

• 

Cambiar o usuario e o grupo propietario dese cartafol e o seu contido: sudo chown root:root /opt/eclipse -R

• 

Dar permisos de control total ao propietario, aos demais usuarios de lectura e execución para ese cartafol e todo o seu contido: sudo chmod
755 /opt/eclipse -R

• 

Un usuario normal podería ir ao cartafol /opt/eclipse e lanzar o IDE, pero mellor crear un menú.

• 

Para iso hai que crear un lanzador (extensión desktop) en /usr/share/applications. Nese directorio están os lanzadores (menús) das demais
aplicacións. Para iso creamos o ficheiro con gedit e executámolo como root: sudo gedit /usr/share/applications/Eclipse.desktop

• 

• 
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Pegamos o contido que se amosa dúas imaxes máis abaixo, modificando as rutas se fose o caso.

Se agora se preme no botón Inicio xa se ve o Lanzador de Eclipse.

• 

Tamén se pode lanzar Eclipse dende a consola. Como root hai que usar o comando sudo, como usuario normal sen sudo.

• 

[Desktop Entry]

Type=Application

Name=Eclipse

Comment=Eclipse Integrated Development Enviroment

Exec=env UBUNTU_MENUPROXY= /opt/eclipse/eclipse

Icon=/opt/eclipse/icon.xpm

Categories=Development;IDE;Java;

NOTA: Na versión 13.10 de Ubuntu se non se engade en Exec env UBUNTU_MENUPROXY non se amosarían os menús da aplicación.

Instalación Android SDK

O proceso de instalación é semellante ao do IDE Eclipse: descargar un paquete e descomprimilo.• 
En http://developer.android.com/sdk/index.html#Other podemos comezar co proceso de instalación.• 
Poderíamos descargar o Bundle asociado ao noso SO e este xa traería integrado nun só paquete: Eclipse + Android SDK + Plugin ADT. Só
restaría instalar o JRE (ou JDK se se desexa).

Poderíase configurar para que puidera ser usado por calquera usuario do sistema do mesmo xeito que se fixo antes con Eclipse e
que se vai facer a continuación co SDK de Android.

♦ 

• 

Pero, como indicamos, vaise instalar cada compoñente por separado.• 

Instalación Android SDK• 
• 
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En http://developer.android.com/sdk/index.html#Other poderemos descargar o SDK para Android. asociado ao noso SO. Neste caso
baixarase o SDK para Linux, fixarse que a versión é a mesma para 32 bits que para 64 bits, co cal é probable que nas versións do SO de 64
bits haxa que instalar librarías de 32 bits que precisen os compoñentes do SDK para ser executadas.

Aceptamos as condicións e descargamos.

• 

• 
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Descomprimimos o ficheiro. En modo gráfico ...

... ou por consola.

• 

Agora xa teríamos unha carpeta co SDK, da que podería facer uso o usuario actual pero non todos os demais do sistema.• 
Por tanto, igual que se fixo antes con Eclipse para configuralo para tódolos usuarios, vaise proceder agora có SDK de Android.• 

Android SDK para tódolos usuarios

Igual que antes: poñer o SDK nunha ruta accesible para tódolos usuarios do sistema: /opt/android-sdk-linux.• 
Logo só resta axustar o propietario e os permisos do cartafol.• 
Pódese facer todo isto dende o contorno gráfico pero vaise realizar dende a consola con sudo.• 

Instalación Android SDK para tódolos usuarios• 

Mover o SDK: sudo mv Descargas/android-sdk-linux /opt/

• 

Axustar os propietarios do cartafol e o seu contido: sudo chown root:root /opt/android-sdk-linux -R

• 

Axustar os permisos ... sudo chmod 755 /opt/android-sdk-linux -R

• 

O contido do cartafol /opt/android-sdk-linux

• 

• 
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O contido do subcartafol tools. Hai un programa chamado android que permite, entre outras cousas, xestionar as APIs do SDK e os
emuladores de dispositivos.

Podemos executalo dende a consola, indicando a súa ruta. Con sudo é executado como root, e sen sudo como un usuario normal.
/opt/android-sdk-linux/tools/android --help.

• 

Como imos actualizar as APIs do SDK e descargar os seus compoñentes é preciso lanzar o Xestor do SDK (SDK Manager) como root:
sudo /opt/android-sdk-linux/tools/android sdk. A opción sdk é a que se usa por defecto cando non se indica ningunha.

• 

• 
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Se se preme na imaxe verase en tamaño real, e poderá apreciarse, que aínda non está o SDK listo para poder crear o noso primeiro
programa: precísanse compoñentes que xa marca por defecto o xestor: Unha API (marca por defecto as últimas, a 5.1.1 e M) e compoñentes
básicos (na imaxe veñen marcadas outras por ser unha versión anterior).

Neste caso, como xa se indicou nun apartado anterior, vanse descargar a API 16 asociada á versión de Android 4.1.2 e se desexa as 5.1.1 e
M. Lembrar que estas dúas últimas APIS ocupan uns 6 GiB.

• 

Aceptar as licencias dos compoñentes.

• 

• 
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Ollo!!! que abaixo hai máis licencias para aceptar. E premer en Install

Comezo da descarga. Da un erro de que non pode parar o servidor ADB. Este compoñente verase nun apartado posterior.

• 

Continúa a descarga.

• 

• 
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Erro de que non pode iniciar o servidor ADB, e isto si que é un problema. Isto pasa nas versión de 64 bits de Ubuntu 13.10, porque para
iniciarse ese servidor precisa unhas librarías de 32 bits que non están instaladas. Logo arranxarase.

Compoñentes do SDK instalados.

• 

• 
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Carpetas creadas e asociadas ao SDK.

NOTA:: Cando decidimos instalar unha nova versión do S.O. Android non é necesario marcar todas as opcións dentro desta API. Así:

SDK: Necesario para poder desenvolver a aplicación. Sempre debe ser marcada.◊ 
Samples for SDK: Documentación de exemplo. Non é necesario marcala.◊ 
System Image (ARM/Intel/MIPS): Cando máis adiante utilicemos un dispositivo virtual para correr as nosas aplicacións, será
necesario ter descargado a lo menos unha destas imaxes. O normal é que se temos un procesador INTEL descarguemos unha
imaxe INTEL xa que despois poderemos instalar un acelerador hardware para dito micro. Se non temos intel poderíamos
descargar calquera das opcións.

◊ 

Google API: O mesmo que o System Image pero para dar soporte a aplicacións que van facer uso de Google Maps. Se non imos
traballar con el non será necesario descargalas.

◊ 

Sources for Android SDK: Fontes das funcións do SDK. Non é necesario descargalas.◊ 

Instalación plugin ADT

Só resta instalar o plugin en Eclipse que permita traballar dende este IDE co SDK de Android.• 
Este plugin chámase: Android Development Tools (ADT) e estende as capacidades de Eclipse para xestionar dispositivos móviles
(emulados e reais), compilar e instalar aplicacións en dispositivos, etc.

• 

En http://developer.android.com/tools/sdk/eclipse-adt.html hai máis información sobre este compoñente e como se pode instalar no IDE.• 

Instalación ADT Plugin• 

En http://developer.android.com/tools/sdk/eclipse-adt.html premer en Installing the Eclipse Plugin

• 

• 
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En http://developer.android.com/sdk/installing/installing-adt.html indica que podemos instalar o Plugin de dúas formas:

Unha descargando o paquete e logo instalalo dende Eclipse ...

• 

... ou copiar o enlace ao repositorio no que se atopa o plugin ADT: https://dl-ssl.google.com/android/eclipse/. Usaremos esta forma.

• 

Lanzar eclipse como root.

• 

• 

http://developer.android.com/sdk/installing/installing-adt.html
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_47.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_48.jpg
https://dl-ssl.google.com/android/eclipse/
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_43.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_ubuntu_44.jpg


Premer en Help -> Install New Software...

Pegar o repositorio ... Premer en Add.

• 

Poñer un nome ao repositorio, neste caso ADT.

• 

Amosa os compoñentes que se van instalar. Na última versión do ADT só hai un compoñente. O compoñente NDK: Native Development Kit
era para desenvolver aplicacións en linguaxe nativa como C ou C++. Máis información: http://developer.android.com/tools/sdk/ndk/index.html

• 

• 
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Dentro dos compoñentes de Developer Tools hai outros como DDMS que se verá nun apartado posterior.

Unha vez marcado todo premer en Next.

• 

Premer en Next.

• 

• 
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Aceptar a licencia.

Proceso de descarga e instalación dos paquetes.

• 

Aceptar a advertencia que indica que hai software sen asinar.

• 

Reiniciar eclipse cando remate a instalación do plugin.

• 

• 
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Advertencia que indica que non se atopa a ruta do SDK de Android. Pechar.

Unha vez instalado o Plugin ADT en Eclipse este permítenos que instalemos un novo SDK de Android descargándoo dende cero, ou usar un
xa instalado. Escoller esta segunda opción e indicar a ruta /opt/android-sdk-linux

• 

• 
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Indicar se se desexa participar nas estadísticas de Google.

Na versión de Ubuntu de 13.10 de 64bits aparecen varios erros que fan mención o problema que se tiña antes co compoñente ADB. Este
servizo é lanzado polo plugin ADT para poder usarse no DDMS como se verá máis tarde.

• 

... aquí indica que precisa unha libraría que non ten.

• 

Entramos igualmente en Eclipse ...

• 

• 
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E vemos dous erros na parte inferior avisando do mesmo.

Librarías de 32 bits precisas para Ubuntu 13.10 Linux de 64 bits

Se o lector está usando unha versión de Ubuntu de 32 bits xa pode pasar ao seguinte punto.• 
Como se viu antes o SDK de Android era válido para as versións de 32bits e 64bits, pero se estamos nun SO de 64 bits, este non ten
instaladas algunhas librarías de 32 bits que precisan algúns compoñentes do SDK, por exemplo o ADB.

• 

O Android Debug Bridge (ADB) é un comando que arranca un servidor que nos vai permitir comunicarnos e interactuar cos dispositivos
físicos ou emulados.

• 

O ADB verase con profundidade nun apartado posterior, por agora so interesa que se poida executar.• 
No enlace hai máis información: http://developer.android.com/tools/help/adb.html• 

Instalación libraría 32 bits• 

Este compoñente atópase na ruta do SDK en: /opt/android-sdk-linux/platform-tools/adb. Ao executalo vese que nos indica un erro cunha
libraría.

• 

Instalamos a libraría, pero de 32 bits, como root: sudo apt-get install lib32stdc++6

• 

• 
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Executamos de novo o comando: /opt/android-sdk-linux/platform-tools/adb e xa amosa a axuda do comando.

Agora xa podemos iniciar Eclipse que non se terá ningún problema co ADB nunha versión linux de 64 bits.• 
Aínda hai que instalar algunha libraría máis de 32 bits, pero imos esperar a que xurda o erro.• 

Configuración Eclipse e plugin ADT. Actualizacións

Agora xa podemos iniciar eclipse sen problemas e imos ver:
Parámetros de configuración de Eclipse.♦ 
Como actualizar Eclipse ou o SDK de Android.♦ 
Que elementos engadiu o plugin ADT á Perspectiva Java de Eclipse.

Unha Perspectiva é unha combinación de pantallas para facilitar o desenvolvemento de aplicacións de distintos tipos.◊ 
Aconséllase que se lle bote un ollo a: "Mi primera hora con Eclipse":
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

◊ 

♦ 

• 

Preferencias• 

Premer en Window -> Preferences.

• 

Na categoría Android pódese ver a ruta do SDK, se esta se perdera, con vir a esta preferencia xa se podería configurar.

• 

• 
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A versión do compilador JDK que vai usar o IDE.

A versión do JRE e a súa ruta.

• 

Actualizacións• 

Hai que lanzar o Eclipse como root (sudo /opt/eclipse/eclipse). En Help -> Check for Updates.

• 

• 
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Comprobando se hai actualizacións do IDE.

Non hai actualizacións.

• 

Perspectiva Java• 

A combinación de ventás (Perspectiva) que se ve é a que se denomina Java EE

• 

Pero ADT instalou compoñentes na Perspectiva Java. Premer en Window -> Open Perspective -> Java

• 

• 
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Aparecen novas iconas, entre elas, o Android SDK Manager e o Xestor de Dispositivos Virtuais.

O mesmo pasa se se preme en Window

• 

Dende o propio Eclipse, o plugin proporciona un enlace ao comando que chama ao Xestor de SDK de Android, que estaba na ruta:
/opt/android-sdk-linux/tools/android sdk. Dende aquí poderíanse instalar/desinstalar compoñentes e incluso actualizalos. Pero hai que
iniciar o Eclipse como root: sudo /opt/eclipse/eclipse. Non o pode facer un usuario normal (ben, salvo que en /opt/android-sdk-linux se lle
dean permisos de escritura a todo o mundo).

• 

Carpetas de traballo

As carpetas que se obteñen finalmente pertencen a 2 tipos:
Carpetas de programas:

/opt/eclipse: Eclipse + plugin ADT◊ 
/opt/android-sdk-linux: Android SDK◊ 

♦ 

Carpetas de configuración de usuario
/home usuario/.eclipse: Carpeta oculta. Contén arquivos de configuración relativos a ese usuario e ao IDE Eclipse.◊ 
/ruta/workspace: Carpeta indicada polo usuario onde se van gardar os proxectos creados no IDE Eclipse.◊ 
/home usuario/.android: Carpeta oculta. Contén arquivos de configuración relativos ao SDK de Android e onde se van
gardar os emuladores de dispositivos móbiles (AVDs) que cree o usuario.

◊ 

♦ 

• 

Dende a sesión do usuario co que se estaba no sistema se estivo executando Eclipse e o SDK de Android como root, aconsellamos, para
que non haxa problemas con permisos, que se borren as tres carpetas asociadas á configuración do usuario. Puidera ser o caso de que xa
non existiran esa carpetas, pero é mellor asegurarse.

• 
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Fixar a icona ao Lanzador

Unha forma de facilitar o acceso a eclipse pode ser fixando a icona ao Lanzador.• 
Hai varias formas de facelo, unha delas é a seguinte, unha vez que se ten o localizado na Lente de Incio, arrastralo ate a barra do Lanzador.• 

Fixar icona ao Lanzador• 
• 

• 
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